
Contents 

1 
 

Contents 
Features of Color Calibration Management Console ............................................................................ 2 
Installation Procedure ............................................................................................................................. 4 
Uninstallation Procedure ........................................................................................................................ 7 
Startup ..................................................................................................................................................... 8 
Main Window ........................................................................................................................................... 9 

File Menu ........................................................................................................................................... 13 
Tools Menu (When the Calibration Sheet is Displayed) .................................................................. 14 
Tools Menu (When the Color Measurement Sheet is Displayed) .................................................... 15 
Help Menu .......................................................................................................................................... 17 
Printer List ......................................................................................................................................... 18 
Calibration Sheet ............................................................................................................................... 20 
Color Measurement Sheet ................................................................................................................. 22 

Checking the Color Calibration Status ................................................................................................ 24 
Executing Color Calibration ................................................................................................................. 27 
Acquiring Color Measurement Data For Any Color Chart .................................................................. 32 
Executing Color Check .......................................................................................................................... 42 
Registering Execution Logs in Favorites ............................................................................................. 48 
Deleting Execution Logs From Favorites ............................................................................................. 50 
Saving Execution Logs on the Computer ............................................................................................. 52 
Switching Display Units ....................................................................................................................... 54 
Getting Audio Notification of Color Calibration Finished ................................................................... 55 



Features of Color Calibration Management Console 

2 
 

Features of Color Calibration Management Console 
Color Calibration Management Console is software that allows you to view the color calibration status and execute 

color calibration on multiple printers. You can also acquire color measurement data and execute color checks on 

printers that have a spectrophotometer unit installed. 

 Display Color Calibration Status 

 Execute Color Calibration 

 Acquire Color Measurement Data 

 Execute Color Check 

Display Color Calibration Status 

The printers connected via the network and USB are displayed in a list in the main window. 

If there are multiple printers, printers where color calibration has been executed on the same paper type and that paper 

is loaded in the printer are displayed in the same calibration group. Printers that are in the same calibration group can be 

corrected to give the same color tones by executing color calibration. 

When a printer is selected from the main window, the color calibration status, execution logs, etc. of that printer are 

displayed. 

For details on how to check the color calibration status, see "Checking the Color Calibration Status (P.24)." 

Execute Color Calibration 

You can execute color calibration. 

Executing color calibration improves color consistency by compensating for slight differences in how color appears due 

to individual variations or aging among the printers. 

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)." 

 

Note 
 In order to execute color calibration on paper other than genuine Canon paper/feed certified paper, a calibration 

target is required for that paper. Calibration targets can be created on a printer with a spectrophotometer unit 

installed by using the Media Configuration Tool that is included with printers that support the spectrophotometer 

unit. 

 

Acquiring Color Measurement Data from the Color Chart 

You can measure the colors of any arbitrary color chart and save the color measurement data on your computer. You 

can then create an ICC profile by importing this data into commercially available ICC profile creation software. 

For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color 

Chart (P.32)." 
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Note 
 This function can be executed when a printer that has a spectrophotometer unit installed is selected. 

 

Execute Color Check 

You can execute a color check. 

When a color check is executed, a built-in pattern is printed, the color difference from a calibration target registered in 

the printer is calculated, and the check results are displayed. 

Execute a color check when you want to check the color status of a printer in detail. 

For the procedure for executing color check, see "Executing Color Check (P.42)." 

 

Note 
 This function can be executed when a printer that has a spectrophotometer unit installed is selected. 
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Installation Procedure 
The installation procedure for the Color Calibration Management Console is as follows. 

1 Start the Color Calibration Management Console installer. 

2 Click the Next button. 

 

3 After reading the license agreement, select I accept the terms of the license agreement and click the Next 

button. 
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4 Choose a location to install the software and click the Next button. 

 

5 Click the Install button. 

 

6 If you want to create a shortcut to Color Calibration Management Console on the Desktop, click the Yes button. 

 



Installation Procedure 

6 
 

7 Select Yes, I want to restart my computer now. or No, I will restart my computer later. and click the Finish 

button. 

 

 To complete the installation of the Color Calibration Management Console, restart your computer. 
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Uninstallation Procedure 
The uninstallation procedure for the Color Calibration Management Console is as follows. 

1 From the start menu, click All Programs>imagePROGRAF Color Calibration Management 

Console>Uninstaller (imagePROGRAF Color Calibration Management Console). 

2 Select Remove and click the Next button. 

 

3 Click the Finish button. 

 

 This completes the uninstallation of the Color Calibration Management Console. 
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Startup 
The startup procedure for the Color Calibration Management Console is as follows. 

Double-click the Color Calibration Management Console icon on the desktop. 

 

This displays the Color Calibration Management Console main window. 

 

 

Note 
 If there is no Color Calibration Management Console icon on the desktop, click start and navigate to All 

Programs>imagePROGRAF Color Calibration Management Console>imagePROGRAF Color Calibration 

Management Console. 
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Main Window 
The Color Calibration Management Console main window consists of a title bar, menu bar, Printer list, Calibration 

sheet, and Color Measurement sheet. 

You can switch between the Calibration sheet and Color Measurement sheet by clicking the ACalibration button or 

BColor Measurement button. You can also switch between the sheets from the File menu in the menu bar. 

 

Title bar 
Displays the model name, port name, and installation location of the printer selected in the Printer list. 

 

Menu bar 
Allows you to select the menu items for the necessary operations. 

 

For details on each of the menu items, refer to the following topics. 

 File Menu (P.13) 

 Tools Menu (When the Calibration Sheet is Displayed) (P.14) 

 Tools Menu (When the Color Measurement Sheet is Displayed) (P.15) 

 Help Menu (P.17) 
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Printer List 
Displays a list of printers that can be controlled. For details, see "Printer List (P.18)." 
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Calibration Sheet 
This sheet allows you to execute color calibration. For details, see "Calibration Sheet (P.20)." 

 

Color Measurement Sheet 
This sheet allows you to acquire color chart measurement data and execute color check. For details, see "Color 

Measurement Sheet (P.22)." 
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Note 
 Enabled when a printer that has a spectrophotometer unit installed is selected. 
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File Menu 
This section describes each of the menu items in the File menu. 

 

Calibration / Color Measurement 
Selects the main window sheet. 

Update Printer List 
Refreshes the Printer list on the left side of the main window with the latest information. 

Printer Information 
Displays the Printer Information dialog box for the printer selected in the Printer list. 

This allows you to check detailed information about the printer. 

Status Monitor 
You can start the imagePROGRAF Status Monitor for the printer selected in the Printer list, allowing you to confirm 

information such as the status of print jobs. 

Accounting 
You can start the imagePROGRAF Status Monitor Accounting Manager main window for the printer selected in the 

Printer list, allowing you to confirm information such as the cost of printing. 

Preferences 
Displays the Preferences dialog box. 

This allows you to select the units displayed in the Color Calibration Management Console, configure the sound that is 

displayed when executing a color calibration, acquiring color measurement data, or executing a color check finishes, 

and configure other settings. 

Exit 
Exits Color Calibration Management Console. 
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Tools Menu (When the Calibration Sheet is Displayed) 
This section describes each of the menu items in the Tools menu when the Calibration sheet is displayed in the main 

window. 

 

Calibration 
Displays the Execute Color Calibration dialog box. 

Executes color calibration on the selected printer. 

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)." 

Close Dialog When Finished 
Selects whether or not to close the progress dialog box automatically when the color calibration finishes. 

When the check box is selected, the progress dialog box closes automatically. 

Calibrated/All/Custom Paper 
Selects the paper types displayed in the main window (Calibration sheet). 

Paper Status 
Displays the Paper Status dialog box. 

This allows you to check the color calibration and color check execution logs for the selected paper. 

Update 
Refreshes the paper list in the main window with the latest information. 
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Tools Menu (When the Color Measurement Sheet is Displayed) 
This section describes each of the menu items in the Tools menu when the Color Measurement sheet is displayed in 

the main window. 

 

Note 
 Enabled when a printer that has a spectrophotometer unit installed is selected. 

 

 

Acquire Color Measurement Data 
Displays the procedure description window or Select Execution Log window. 

This allows you to measure the colors of a color chart in the selected printer and acquire the color measurement data. 

For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color 

Chart (P.32)." 

Color Check 
Displays the Execute Color Check dialog box. 

Execute color check on the selected printer. 

For the procedure for executing color check, see "Executing Color Check (P.42)." 

Display Procedure Window 
Selects whether or not to display the procedure description window when executing Acquire Color Measurement 

Data. 

When the check box is selected, the procedure description window is displayed. 

Close Dialog When Finished 
Selects whether or not to close the progress dialog box automatically when Color Check or Acquire Color 

Measurement Data finishes. 

When the check box is selected, the progress dialog box closes automatically. 

Favorites 
Displays the Favorites Management dialog box. 
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This allows you to check the execution logs registered in the favorites. 

Log Details 
Displays the Execution Log Details dialog box. 

This allows you to check the details of the execution log selected in Execution Logs in the main window. 

Save Data 
Displays the Output Color Measurement Data dialog box. 

This saves the color measurement data of the execution log selected in Execution Logs in the main window on the 

computer. 

 

Note 
 This menu cannot be selected if multiple execution logs are selected. 

 

Output Execution Log CSV 
When Selected Logs is selected, this saves the execution log selected in Execution Logs in the main window on the 

computer in a CSV format file. 

When All Logs is selected, this saves all of the execution logs displayed in Execution Logs in the main window on the 

computer in a CSV format file. 



Help Menu 

17 
 

Help Menu 
This section describes each of the menu items in the Help menu. 

 

Help 
Displays the Color Calibration Management Console help. 

About 
Displays the About dialog box, which allows you to check the version of Color Calibration Management Console. 
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Printer List 
The printers displayed in the Printer list are printers connected via the network or USB that satisfy the following 

conditions. However, printers that are connected via a server are not displayed. 

 Printers that are compatible with the Color Calibration Management Console 

 Printers where the printer driver is installed 

 

Printer 
If color calibration is executed on the paper being fed, printers that are being fed the same paper are displayed under the 

Calibration group. 

 is displayed on printers that have a message related to color calibration. 

 is displayed on printers where the spectrophotometer unit is installed. 

Double-click the printer name to display the Printer Information dialog box, allowing you to check the detailed 

printer information. 

 

Note 
 Printers that are added, deleted, or have their name changed while Color Calibration Management Console is 

running are not updated in the Printer list. If you want to update the Printer list, exit and then restart Color 

Calibration Management Console. 

 

 button 
Click this button to refresh the Printer list with the latest information. 
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Printer Information button 
Click this button to display the Printer Information dialog box for the selected printer, allowing you to check the 

detailed printer information. 

Status Monitor button 
Click this button to start the imagePROGRAF Status Monitor for the selected printer, allowing you to confirm 

information such as the status of print jobs. 

Accounting button 
Click this button to start the imagePROGRAF Status Monitor Accounting Manager main window for the selected 

printer, allowing you to confirm information such as the cost of printing. 
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Calibration Sheet 
This sheet allows you to execute color calibration and check the color calibration status of the printer selected in the 

Printer list. 

 

Paper Being Fed 
Displays the media type being fed in the printer. 

Calibration button 
Click this button to display the Execute Color Calibration dialog box. 

Executes color calibration on the selected printer. 

For the procedure for executing color calibration, see "Executing Color Calibration (P.27)." 

Advisability of executing color calibration 
Displays the status until it is recommended that you execute color calibration. The progress bar grows until the time 

when calibration is recommended. 

Paper Status button 
Click this button to display the Paper Status dialog box. 

This allows you to check the color calibration and color check execution logs for the selected paper. 
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Color calibration status for each paper 

 

Click the  button to refresh the list with the latest information.  is displayed on the paper currently being fed in 
the printer. 

The paper types displayed in the list are as follows. 

When Calibrated is selected 
Paper types that are registered in a printer where color calibration has been executed are displayed. 

When All is selected 
Paper types registered in a printer are displayed. 

When Custom Paper is selected 
Paper types other than genuine Canon paper and feed certified paper that are registered in a printer are displayed. 
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Color Measurement Sheet 
This sheet allows you to use the spectrophotometer unit to measure colors. 

 

Color Measure button 
Click this button to display the procedure description window or Select Execution Log window. 

This allows you to measure the colors of a color chart in the selected printer and acquire the color measurement data. 

For the procedure for acquiring color measurement data, see "Acquiring Color Measurement Data For Any Color 

Chart (P.32)." 

Color Check button 
Click this button to display the Execute Color Check dialog box. 

Execute color check on the selected printer. 

For the procedure for executing color check, see "Executing Color Check (P.42)." 

Execution Logs 
Displays the execution logs of acquiring color measurement data. 

 is displayed on the paper being fed. 

The name registered in the favorites is displayed in Name. 

Save Data button 
Click this button to display the Output Color Measurement Data dialog box. 

This saves the color measurement data from the selected execution log on the computer. 
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Favorites button 
Click this button to display the Favorites Management dialog box. 

This allows you to check the execution logs registered in the favorites. 

Log Details button 
Click this button to display the Execution Log Details dialog box. 

This allows you to check the details of the selected execution log. 
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Checking the Color Calibration Status 
You can check the color calibration status and execution logs on the Calibration sheet in the main window. 

1 Open the Calibration sheet. 

 

2 Select the printer you want to check the color calibration status of from the Printer list. 

 

 

Note 
 If there are multiple printers, printers that have the same paper type loaded and where color calibration has been 
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executed on that paper are displayed in the same calibration group. 

 

3 Check the color calibration status of the paper being fed in the upper part of the Calibration sheet. 

 

4 Select Calibrated and click the  button. 
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5 Check the color calibration logs in the lower part of the Calibration sheet. 
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Executing Color Calibration 
The procedure for executing color calibration is as follows. 

Getting the Printer Ready 

1 You can confirm whether the paper to be loaded can be used in color calibration. 

2 Load the paper. 

 

Note 
 If Adj. Quality has not been executed even once on the paper you are using when you execute Auto Adjust (High 

Precision), execute Adj. Quality in the control panel menu. 

 

3 If a spectrophotometer unit is mounted, select the White/Black Backing Plate color. 

 We recommend white. 

 

Note 
 For the color of the White/Black Backing Plate, continue using the selected color without changing each time you 

execute color calibration. 

 

Executing Color Calibration 

1 Open the Calibration sheet. 
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2 Select the printer you want to execute color calibration on from the Printer list. 

 

3 Click the Calibration button. 
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4 The Execute Color Calibration dialog box is displayed. 

 

 Color Calibration Type 
 Select Auto Adjust (High Precision) to execute color calibration using the spectrophotometer unit, or select 

Auto Adjust to execute color calibration using the sensors in the printer. 

 

Note 
 Enabled when a printer that has a spectrophotometer unit installed is selected. 

 

 Pattern Size 
 You can select this setting when Auto Adjust (High Precision) is selected in Color Calibration Type. 

 We recommend Larger when you want to prioritize the color measurement precision. 

 

Note 
 Enabled when a printer that has a spectrophotometer unit installed is selected. 

 

5 Click the OK button. 
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6 When the Execute Color Calibration dialog box is displayed, check the details. 

 

7 Click the Execute button. 

 Color calibration will be executed. 

 

 

Note 
 You can exit the color calibration in the middle by clicking the Cancel button. However, it may take some time to 

end. 
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8 Click the OK button. 
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Acquiring Color Measurement Data For Any Color Chart 
The procedure for printing a color chart, measuring the colors, and saving the color measurement data on a computer is 

as follows. 

The color measurement data saved on the computer can be used such as for creating ICC profiles. ICC profiles are 

created using commercially available software. 

Created ICC profiles can be used by the printer driver.  

 

Note 
 This step can be executed when a printer that has a spectrophotometer unit installed is selected. 

 

Getting the Printer Ready 

1 Confirm whether the paper to be loaded can be used for acquiring color measurement data. 

2 Load the paper. 

 

Note 
 If Adj. Quality has not been executed even once on the paper you are using, execute Adj. Quality in the control 

panel menu. 

 

3 Select the White/Black Backing Plate color. 

Acquiring Color Measurement Data 

1 Open the Color Measurement sheet. 
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2 Select the printer you want to measure the color chart on from the Printer list. 

 

3 Click the Color Measure button. 
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4 Check the color chart measurement procedure in the procedure description window and then click Start. 

 

5 Select New in Favorites and then click Next. 

 

 

Note 
 To perform color chart measurement using the setting values when executed previously, select the execution log in 

the Favorites sheet or History sheet. 
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6 Select the color chart, configure the color chart print settings, and then click Next. 

 

Setting Item Details 

Chart Selects the color chart to print. If the color chart you want to print is not 

displayed in the list, click the Browse button and then select the color chart. 

You can only select color charts that are CGATS format RGB. 

Roll Paper Width Click the Acquire Info. button to display the paper width of the roll loaded 

in the printer. 

Conserve Paper Selecting this check box allows you to conserve paper by reducing the gap 

between the pieces of a color chart when the chart is printed split into pieces. 

Media Type Select the type of paper. 

Print Priority Choose the graphic elements that you want to emphasize for printing. 

Print Quality Choose the print quality. 

Extend print pass Uneven printing may occur when printing with the Highest setting in Print 

Quality. Selecting this check box may improve the uneven printing. 

However, the printing speed will be reduced. 

Paper Source Selects the paper source. 

Automatic Cutting Selects how to cut the paper when Acquire Color Measurement Data 

finishes. 

Print Labels Select this check box to print the color chart printing information. 
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7 Configure the color measurement settings and drying settings, and then click Next. 

 

Setting Item Details 

Color Measurement 

Preferences 

Configures the pattern size to print the color charts and the drying settings 

for the printed color charts. 

Choose Standard to print at the standard pattern size and dry using the 

standard setting values. 

Click the Settings button to display the Color Measurement Preferences 

dialog box, which allows you to configure the pattern size and drying 

method in detail.(*1) 

Reduce Drying Time Selecting this check box reduces the drying time. 

Once the time configured in the Color Measurement Env. sheet in the 

Preferences dialog box has elapsed, color measurement proceeds without 

performing any further drying with the ventilation fan. 

Specify a time that offers sufficient drying by air drying in the Preferences 

dialog box. If you perform color measurement while the ink is not dry, the 

measurements may not be correct. 

The Preferences dialog box is displayed when you click Preferences in the 

File menu. 

If the number of patterns is small, drying will finish in a shorter amount of 

time than the time configured in the Preferences dialog box. If this happens, 

the drying time will not be reduced even if the Reduce Drying Time check 

box is selected. 

Illumination Select the illumination from D50, D65, and A. 
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Setting Item Details 

Observer Angle Selects the observer angle. 

UV Cut Selects whether or not UV cut is used. 

Color Measurement Value Saves the color measurement data for the color measurement values where 

the check box is selected. 

The Lab check box cannot be cleared. 

*1:If you want to enlarge the color chart pattern or configure the color chart drying settings in detail, click the Settings button to 

display the Color Measurement Preferences dialog box. 

 

 

Setting Item Details 

Pattern Size Selects the pattern size of the color chart. 

We recommend Larger when you want to prioritize the color measurement 

precision. 

Drying Method Choose Ventilation Fan to dry using the ventilation fan or Air Drying to 
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Setting Item Details 

dry without using the ventilation fan. 

Ventilation Fan Configures the drying time and airflow for the ventilation fan. 

Time Configures the drying time for the ventilation fan for each pattern. 

The number of lines that are dried at one time by the ventilation fan varies 

depending on the size selected in Pattern Size. 

As the time increases, the adhesion of the ink improves and the color tones 

become more stable. 

Reduce Drying Time Selecting this check box reduces the drying time. 

Once the time configured in the Color Measurement Env. sheet in the 

Preferences dialog box has elapsed, color measurement proceeds without 

performing any further drying with the ventilation fan. 

Specify a time that offers sufficient drying by air drying in the Preferences 

dialog box. If you perform color measurement while the ink is not dry, the 

measurements may not be correct. 

The Preferences dialog box is displayed when you click Preferences in the 

File menu. 

If the number of patterns is small, drying will finish in a shorter amount of 

time than the time configured in the Preferences dialog box. If this happens, 

the drying time will not be reduced even if the Reduce Drying Time check 

box is selected. 

Airflow Selects the airflow of the ventilation fan. 

Air Drying Sets the period between the color chart being printed and the color 

measurement starting. 

If the Dry Separated Chart check box is selected, printing and air drying 

are repeated for each separated color chart. This makes it harder for the color 

charts to become scratched or soiled, but also increases the time taken by the 

operation. 

If the Dry Separated Chart check box is clear, printing and air drying the 

color chart are performed once. This reduces the time taken by the 

operation, but may scratch or soil the end of the color chart and paper. 

However, this does not affect the color measurement results. 

Position of Ventilation Fan If you are using paper that has a tendency to curl or paper that does not dry 

easily, select High so that the paper does not come into contact with the 

paper presser. 

Note that when High is selected, we recommend that you set the Time 

longer and the Airflow stronger compared with when Standard is selected 

because of the larger distance between the ventilation fan and paper. 
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8 The View Settings window is displayed. Check the details of the settings and click the OK button. 

 

 

Note 
 Click the Add to Favorites button to display the Add to Favorites dialog box, which allows you to add the setting 

details to favorites. 

 

9 The Output Color Measurement Data dialog box is displayed. 

 Select the file to save the color measurement data into and click the OK button. 

 

10 The Acquire Color Measurement Data dialog box is displayed. 



Acquiring Color Measurement Data For Any Color Chart 

40 
 

 Click the Execute button. 

 

 The color chart is printed and color measurement begins. 

 

 

Note 
 You can exit the acquire color measurement data operation in the middle by clicking the Cancel button. However, 

it may take some time to end. 

 



Acquiring Color Measurement Data For Any Color Chart 

41 
 

11 Click the OK button. 

 

 Once the color measurement has finished, the color measurement data is saved on the computer. 
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Executing Color Check 
When a color check is executed, a built-in pattern is printed, the color difference from a calibration target registered in 

the printer is calculated, and the check results are displayed. 

 

Note 
 This step can be executed when a printer that has a spectrophotometer unit installed is selected. 

 When printing the color check adjustment pattern, the calibration adjustment values are applied even if Use Adj. 

Value is set to Disabled in the Control Panel menu. 

 

Setting the Color Check Threshold Value 

1 Double-click the printer you want to execute the color check on in the Printer list. 
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2 Click the Settings button for Color Check in the Printer Information dialog box. 

 

3 Enter the color check threshold value in ΔE and click the OK button. 

 

Getting the Printer Ready 

1 Confirm whether the paper to be loaded can be used for color checks. 

 Paper for color check is paper that can be used with the Auto Adjust (High Precision) setting on the 

spectrophotometer unit. 
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2 Load the paper. 

 

Note 
 If Adj. Quality has not been executed even once on the paper you are using, execute Adj. Quality in the control 

panel menu. 

 

3 Select the White/Black Backing Plate color. 

 

Note 
 For the color of the White/Black Backing Plate, select the color from when color calibration was executed using 

the spectrophotometer unit. 

 (See "Executing Color Calibration (P.27).") 

 

Executing Color Check 

1 Open the Color Measurement sheet. 
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2 Select the printer you want to execute color check on from the Printer list. 

 

3 Click the Color Check button. 

 

4 The Execute Color Check dialog box is displayed. 

 Select Pattern Size. 



Executing Color Check 

46 
 

 To increase the precision of the color check, we recommend that you configure the same settings as when Auto 

Adjust (High Precision) was executed in color calibration. (See "Executing Color Calibration (P.27).") 

 

5 Click the OK button. 

6 When the Execute Color Check dialog box is displayed, check the details. 

 

7 Click the Execute button. 
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 The color check is executed. 

 

 

Note 
 You can exit the color check in the middle by clicking the Cancel button. However, it may take some time to end. 

 

8 Check the results. 

 

 

Note 
 We recommend that you execute color calibration if the results exceed the threshold values. 

 (See "Executing Color Calibration (P.27).") 
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Registering Execution Logs in Favorites 
You can register frequently used execution logs in favorites for Acquire Color Measurement Data. Registering an 

operation in favorites allows you to attach a separate name for easily recalling the operation. 

 

Note 
 This step can be executed when a printer that has a spectrophotometer unit installed is selected. 

 You can register up to 30 execution logs in the favorites. 

 

1 Select the execution log to register in favorites in Execution Logs in the main window (Color Measurement 

sheet). 

 

2 Click the Log Details button. 
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3 Click the Add to Favorites button in the Execution Log Details dialog box. 

 

4 Enter the name in Name. Enter a comment in Comment if needed. 

 

5 Click the OK button. 
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Deleting Execution Logs From Favorites 
You can delete Acquire Color Measurement Data execution logs from the favorites. 

 

Note 
 This step can be executed when a printer that has a spectrophotometer unit installed is selected. 

 

1 Click the Favorites button in the main window (Color Measurement sheet). 
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2 Select execution log that you want to delete in Favorites and click the Delete from Favorites button. 

 

3 Click the OK button. 
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Saving Execution Logs on the Computer 
You can save Acquire Color Measurement Data execution logs on the computer. 

 

Note 
 This step can be executed when a printer that has a spectrophotometer unit installed is selected. 

 

1 Select the execution log to save on the computer in Execution Logs in the main window (Color Measurement 

sheet). 

 

2 Select Output Execution Log CSV > Selected Logs from the Tools menu. 

 

Note 
 To save all of the execution logs, select All Logs. 
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3 Enter the file name and save. 
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Switching Display Units 
The units displayed in the Color Calibration Management Console can be switched between millimeters and inches. 

1 Select Preferences from the File menu. 

2 Select the display units in the Units sheet in the Preferences dialog box and then click the OK button. 
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Getting Audio Notification of Color Calibration Finished 
You can be notified by sound when color calibration finishes. 

1 Select Preferences from the File menu. 

2 Select the Color Calibration check box in the Sound sheet in the Preferences dialog box and then click the 

Browse button and select the audio file. 

 

 

Note 
 If you want to check the sound in the selected audio file, click the Test button. 

 

3 Click the OK button. 
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